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For yoursafety

For your safety
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Read these simple guidelines. Breaking the rules may be dangerous or illegal.
Further detailed information is given in this manual.
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Do not switch the radio card on when wireless equipment use is prohibited
or when it may cause interference or danger.

Road safety comes first
Don't use the radio card while driving.

Interference
All radio cards may get interference, which could affect performance.

Switch off in hospitals

Follow any regulations or rules. Switch the radio card off near medical
equipment.

Switch off in aircraft

Wireless devices can cause interference in aircraft.

Switch off when refuelling

Don't use the radio card at a refuelling point. Do not use near fuel or
chemicals.

Switch off near blasting

Don't use the radio card where blasting is in progress. Observe restrictions,
and follow any regulations or rules.

Use sensibly

Use only in the normal position. Don't touch the antenna unnecessarily.

Qualified service
Only qualified personnel may repair radio card equipment.

Accessories
Use only approved accessories. Do not connect incompatible products.

Water-resistance
Your radio card is not water-resistant. Keep it dry.

Backup copies
Remember to make backup copies of all important data.

Connecting to other devices

When connecting to any other device, read its user's guide for detailed
safety instructions. Do not connect incompatible products.
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Network Services

The radio card described in this guide is approved for use on the EGSM 900 and
GSM 1800 networks.

Dualband is a network dependant feature. Check with your local service provider
if you can subscribe to and use this feature.

A number of features included in this guide are called Network Services. These are
special services that you arrange through your wireless service provider. Before
you can take advantage of any of these Network Services, you must subscribe to
them through your service provider and obtain instructions for their use from your
service provider.

Note: Some GSM networks may not support all language-dependent
characters and/or services.

© Nokia Corporation 2004. All rights reserved.
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Introduction

Introduction

Important!
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The Nokia D211 is a multimode radio card that combines General Packet Radio
Service (GPRS), GSM high-speed data (HSCSD), and Wireless Local Area
Network (WLAN).

With the Nokia D211 you can send and receive e-mail, text messages, data and fax
files, and access the Internet. Note that with the Nokia D211 you cannot make or
receive voice calls.

The Nokia D211 operates on the GSM 900/1800 networks and IEEE 802.11b-
compliant WLANSs. It plugs into compatible portable computers or other devices
with a type Il or Il PC card slot. The Nokia D211 is equipped with an integrated
smart card reader: Wired Equivalent Privacy (WEP) keys and personal network
profiles that make moving between networks easy, can be stored on a SIM card.

Supported operating systems are: Windows 98 Second Edition, Windows Me,
Windows 2000, and Windows XP. For other supported operating systems and
software updates, please check the Nokia Web site at www.club.nokia.com.

0 Warning: Do not use the radio card when the use of a wireless device is
prohibited or when it may cause interference or danger. Note that the radio
card may cause similar interference as any cellular device (e. g. mobile phone)
and must not be used in areas where the use of any such device is prohibited.

Warning: Be careful when moving your computer so that you do not cause
damage to the protruding end of the inserted radio card.

Warning: Using the Nokia D211 in some countries or regions may be illegal.
Consult local authorities on the regulations concerning the use of the
Nokia D211.

Note: Transmitted data is not encrypted by the radio card by default.

0O 0O

Warning: Use only accessories approved by the radio card manufacturer for
use with this particular radio card model. The use of any other types may
invalidate any approval or warranty applying to the radio card, and may be
dangerous.

For availability of approved accessories, please check with your dealer.
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Data and fax communication

The Nokia D211 provides the functionality of a wireless modem. In order to be able
to connect to a remote computer, to send and receive files, e-mail and faxes, and
to access the Internet, you need to take the following points into account:

® You need the appropriate data and fax communications software installed on
your computer. You can use the Nokia D211 with a variety of commercially
available Windows 98 Second Edition, Windows Me, Windows 2000, and
Windows XP compatible data and fax communications applications, such as
Dial-Up Networking and HyperTerminal.

® The data and fax communications applications must be correctly configured
for use with the Nokia D211, according to the instructions given in the
documentation of these applications and your compatible computer.
Remember to select the Nokia D211 as the modem for each application.

® The data transfer and fax functions depend on the applications you have
chosen, and not only on the computer or the Nokia D211. For information on
how to use an application, please refer to that application's documentation.

® You need to subscribe to the corresponding data and fax services from your
service provider or network operator. Contact your service provider for
information about the availability and details of the services in your home
network. Internet access requires that you have subscribed to the data service
and obtained an Internet access point from your service provider.

The Nokia D211 can also be controlled with AT commands. For more information,
please refer to the Developer Manual for Nokia D211, which can be found at
www.forum.nokia.com.

About data transmission

© Nokia Corporation 2004. All rights reserved.

The Nokia D211 employs the data transmission capabilities of the WLAN and GSM
network in order to send and receive data, to browse the Internet, to send

short messages and e-mail, and to establish connections with other computers,
for example.

Data connections may be made from most locations where your radio card
operates. However, it is recommended that you move the radio card to a location
where the strongest possible network signal can be obtained. When the signal is
strong, data transmission is more efficient.

The following factors may impair wireless connections:

Noise - Electronic appliances and equipment can cause radio interference. Also in
areas where radio cards are prevalent, other radio cards can impair the wireless
connection.
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Roaming - As the radio card user moves from one WLAN access point coverage
area or GSM network cell to another, the signal strength of the channel drops. As
a consequence, the network may hand the user over to a coverage area and
frequency where the signal is stronger. Due to varying network traffic loads,
roaming may also occur when the user is stationary. Such roaming may cause
slight delays in transmission.

Electrostatic discharge - A discharge of static electricity from a fingerora
conductor may cause erroneous functionsin electrical devices. The discharge may
result in unstable software operation. Network connections may become
unreliable, data may become corrupted, and transmission halted. In those cases,
end the existing connection (if any), stop the radio card, and remove it from

the PC card slot. Then re-insert the radio card into the PC card slot and try
connecting again.

Dead spots and dropouts - Dead spots are areas where radio signals cannot be
received. Dropouts occur when the radio card user passes through an area where
the radio signal is blocked or reduced by geographical or structural obstructions,
such as concrete walls.

Signal impairment - Distance and obstacles can cause signals to become out-of-
phase. They can also cause reflected signals. Both situations result in a loss of
signal strength.

Low signal strength - Due to either distance or obstacles, the radio signal
strength from a WLAN access point or GSM cell site may not be strong or stable
enough to provide a reliable connection for communication. Therefore, to ensure
the best possible communication, remember to consider the following points:

® Data connection works best when the radio card is in a stationary position.
Attempting wireless data communication while in a moving vehicle is not
recommended. Fax transmission is more easily impaired than data or text
message transmission.

® Do not place the radio card on a metal surface.

General Packet Radio Service (GPRS)
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GPRS is a packet data technology where information is sent in short bursts of data
over the mobile network. The benefit of sending data in packets is that the
network is occupied only when sending or receiving data. GPRS as such is a data
bearer that enables wireless access to data networks like the Internet. The
applications that use GPRS are SMS messaging and GPRS dial-up (for example,
the Internet and e-mail).

Before you can use GPRS technology:

®* You need to subscribe to GPRS service.

For availability and subscription to GPRS service, contact your service provider
or network operator.
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® You need to save the GPRS settings for the applications used over GPRS.
See "Messages"” on page 36 for configuring text message settings.

See also “Creating new profiles” on page 26 and "Data and fax
communication” on page 8.

Please refer to the Data Security document found on the Nokia D211 CD-ROM for
information on security issues.

Pricing for GPRS and applications

Both the active GPRS connection and the applications used over GPRS, for
example sending and receiving data and text messages, are priced. For more
detailed information on fees, contact your service provider or network operator.

High Speed Circuit Switched Data (HSCSD)

The Nokia D211 enables you to use GSM high-speed data services (HSCSD). The
standard GSM data transmission rate is 9.6 kbit/s, but HSCSD technology allows
for higher data transmission rates, making, for example, the downloading of large
files faster and more convenient.

HSCSD technology is based on the use of multiple timeslots at the same time.
Depending on the network, the data transmission speed in a single timeslot is 9.6
or 14.4 kbit/s. When sending and receiving e-mail, the 14.4 kbit/s data
transmission speed can be doubled up to 28.8 kbit/s, and in Internet connections
a download speed of up to 43.2 kbit/s can be achieved if supported by the
equipment of the network operator and the Internet service provider.

The use of GSM high-speed data services requires that your network supports
HSCSD technology and that you have subscribed to this service. For more
information, contact your service provider or network operator.

See also "Data and fax communication” on page 8.

Please refer to the Data Security document found on the Nokia D211 CD-ROM for
information on security issues.

Wireless Local Area Network (WLAN)

© Nokia Corporation 2004. All rights reserved.

The radio card described in this document is approved for use in a Wireless Local
Area Network (WLAN).

Warning: This equipment operates at 2.4 - 2.4835 GHz. Note that in France
the use of this equipment is only allowed at the frequency band of 2.445 -
2.4835 GHz (channels 10, 11, 12, and 13).

10
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The Nokia D211 supports the following WLAN features:

* |EEE 802.11b standard
® Dataratesof 1,2, 5.5,and 11 Mbit/s

® Qperation at a frequency of 2.4 GHz using Direct Sequence Spread Spectrum
(DSSS) radio technology

* Wired Equivalent Privacy (WEP) data encryption with keys up to 152 bits.

The Nokia D211 enables you to wirelessly connect compatible laptop computers,
hand-held devices, desktop PCs, and other devices with a type Il or Il PC card slot
to a wired local area network through a WLAN access point. Instead of cables,
radio waves are used to transmit and receive data over the air.

If you move the computer to another location within the WLAN and out of range
of a WLAN access point, the roaming functionality can automatically connect
your computer to another access point that belongs to the same network. As long
asyou remain within range of access points that belong to the same network, your
computer can stay connected to the network.

The Nokia D211 enables different types of communication in a WLAN. There are
two operating modes to choose from: infrastructure and ad hoc.

Infrastructure
The infrastructure operating mode allows two kinds of communication:
* Wireless stations communicate with each other through a WLAN access point.

*  Wireless stations communicate with a wired LAN station through a WLAN
access point.

\\\\\\\\ (««“(“m.

\\\\\\

Figure 1 - Infrastructure network

The advantage of the infrastructure operating mode is that you can have more
control over network connections because they pass through an access point. A
wireless station can access the services that are available in a reqular wired LAN:
company database, e-mail, the Internet, and other network resources, for example.

11



SIM services
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Ad hoc

Inthe ad hoc operating mode, wireless stations send and receive data directly with
each other; no access point is required. Simply insert the radio cards into the
stations, make the necessary configurations, and start communicating. Ad hoc
networking is easy to set up, but communication is limited to stations that are
within range. As long as the stations are within range, you can, for example, share
and exchange files.

Figure 2 - Ad hoc network

See "Setting up and joining ad hoc networks" on page 22 for how to set up an ad
hoc network.

SIM services refers to a service which enables you to access the Internet via your
service provider's or network operator's own public network. Your service provider
may, for example, offer you the possibility to check data from your company
intranet, send and receive e-mail, and save documents. SIM services are usually
available in public places such as hotels, airports, railway stations, business
centres, and corporate buildings.

o Note: Before you can take advantage of the SIM services, you must subscribe
to these services from your service provider or network operator and obtain
instructions for use.

A SIM card is used as a means for user identification: the data stored on the SIM
card is read, and if valid, you are allowed to connect to the Internet and intranets.
The SIM card is provided by the service provider or network operator.

Accounting data, such as used access time and/or transferred data, is passed from
the network on to the service provider for billing purposes. Accounting begins
when the wireless station is authenticated and ends when the wireless station
logs off.

Note: The actual invoice for services from your service provider may vary,
depending upon network features, rounding-off for billing, taxes and
so forth.

12
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Security in WLAN

Antennas
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Security issues should always be carefully considered to ensure the secure
transmission of data in both wired and wireless LANs. In current wireless systems,
for example, WLAN access points need to authenticate wireless stations to
prevent unauthorised access to the network. Authentication is a service that
confirms the identity of an entity, such as a user or a computer, or confirms the
origin of a transmitted message.

The Nokia D211 supports the Wired Equivalent Privacy (WEP) protocol, which
offers basic protection in WLAN. The WEP protocol utilises the RC4 algorithm with
anup to 152-bit secret key, which encrypts data before it is transmitted over radio
waves. When the wireless stations in a WLAN wish to communicate using WEP,
they must have the same WEP key in possession.

The Nokia D211 is also compatible with leading Virtual Private Network (VPN)
clients over GPRS and WLAN. VPN is recommended for more secure network
access.

The Nokia D211 is equipped with an integrated smart card reader. SIM cards and
smart card readers provide a tool for managing secure user authentication in a
WLAN. SIM cards also provide an easy way for users to carry an authentication
device with them. On a SIM card users can store important information, such as
WEP keys and network profiles.

The smart card reader reads the data stored on the computer chip and sends it to
the network for processing. The SIM card is protected by a PIN code; to access the
contents of the SIM card, you need to enter the correct PIN code.

0 Caution: Keep all miniature SIM cards out of small children’s reach.

Please refer to the Data Security document found on the product CD-ROM for
more information on security issues.

The Nokia D211 has built-in antennas inside an extension box. In this document
antenna refers to the extension box and the antennas inside it.

Figure 3 - Extension box of the Nokia D211

13
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When connecting to a WLAN, make sure that the antenna is pointing towards the
WLAN access point and placed in an open area. Do not cover the antenna.

Use only the supplied antenna. Unauthorised antennas, modifications, or
attachments could damage the radio card and may violate regulations governing
radio devices.

14
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Installation

Installation

There are some slight differences in the installation process between the different
Windows operating systems. If the installation differs from the steps described
below, follow the instructions on the screen.

The Nokia D211 software requires 20 MB of free disk space.

Installing the Nokia D211 software

© Nokia Corporation 2004. All rights reserved.

o Note: Do not insert the radio card into your computer until the installation
program instructs you to do so.

1 Exitall Windows programs. Insert the CD-ROM into the CD-ROM drive of
your computer.

If the CD-ROM is not launched automatically, go to your CD-ROM drive (e.g.
drive D) and double-click on Start.exe.

2 Select the language for the CD-ROM and installation program and read
through and accept the Nokia license agreement. If you do not accept the
license agreement, you cannot use the CD-ROM.

3 The main screen of the CD-ROM opens. Click Install to start the installation.
4 The Welcome page of the installation wizard opens. Click Next to continue.

5 Read through and accept the Nokia license agreement. If you do not accept the
license agreement, you cannot use the software and the installation procedure
stops. Click | Accept to accept the license agreement.

6 Select the destination folder for the software. The default folder is C:\Program
Files\Nokia\Nokia D211. If you want to install the software in another drive or
folder, click Browse. When you have selected the correct destination folder,
click Next.

o Note: You cannot install the Nokia D211 software on a network drive.

7 Select the type of installation you want. The Administratoroption is for system
administrators only. Custom allows you to choose the individual software
components to be installed, and is recommended for advanced users. Typical
installs the most common software components. This option is recommended
for most users. When you have selected the desired type of installation,
click Next.

8 Check the installation settings. To accept them, click Next. To change the
settings, click Back, make the changes, and then click Next. The installation
program starts copying the files.

9 When the installation program prompts you to insert the radio card, insert it
into the PC card slot of your computerasshown in Figure 4. Note that the radio

15
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Installation

card is notinserted all the way into the PC card slot and there is a gap between
the protruding extension box and the computer. Do not use excess force when
inserting the card.

Figure 4 - Inserting the radio card

In the Windows 2000 operating system you are informed that no digital
signature was found. Click Yes in each dialog box to continue with the
installation.

In Windows XP, the operating system opens Found New Hardware wizards. For
each of these wizards, first select the option Install the software
automatically, and then select Continue Anyway to continue with the
installation.

10 The Completion page informs you when the installation is completed. Remove

the CD-ROM from the CD-ROM drive and click Finish. You may need to restart
your computer.

11 Adialog box asks if you want to create a network profile now. Remember that

you can create and edit your own network profiles at any time. If you do

not want to create a profile, click No and the installation procedure is
completed. If you want to create a profile, click Yes and the Welcome window
of the profile wizard opens. See “Creating new profiles” on page 26 for more
information.

o Note: If you want other applications to be able to use the smart card reader

of the Nokia D211, you need to install separately a PC/SC (Personal Computer
Smart Card) compliant smart card driver on your computer. Install the smart
card driver only if you want to use other applications or special types of
smart cards with the smart card reader of the Nokia D211. To install the
driver, select Custom as the installation type (see step 7 above) and select the
PC/SC smart card driver component. In the Windows 98 and Me operating
systems you must have the Microsoft Smart Card Base Components 1.0 or
later installed.

16



Installation

Modifying the installation

You can alter the installation of the Nokia D211 by adding or removing
components, for example.

1 Exitall Windows programs. Insert the CD-ROM into the CD-ROM drive of
your computer.
If the CD-ROM is not launched automatically, go to your CD-ROM drive (e.g.
drive D) and double-click on Start.exe.

2 Select the language for the CD-ROM and installation program and read
through and accept the Nokia license agreement. If you do not accept the
license agreement, you cannot use the CD-ROM.

3 The main screen of the CD-ROM opens. Click Install to start the installation.

4 When the Welcome page of the installation maintenance program opens,
choose from the following options:

Modify - You can install new components or remove existing ones.
Update - You can update the installed components and network profiles.

Uninstall - You can remove the Nokia D211 program files and drivers from your
computer.

When you have selected the option, click Next.

5 The selected wizard opens. Make the changes and click Next to continue.

6 Check the settings. To accept them, click Next. To change the settings, click
Back, make the changes, and then click Next.

7 The modification starts. The Completion page informs you when the
modification is completed. Click Finish.

Uninstalling the Nokia D211 software

© Nokia Corporation 2004. All rights reserved.

i\ Caution: Before you start uninstalling the Nokia D211 software, you must
~ first stop the radio card and then remove it from the PC card slot of the
computer. See "Removing the radio card" on page 22 for more information.

Close all dialog boxes in the user interface before uninstalling the Nokia D211.

To uninstall the Nokia D211 software:

1 From the Start menu, select Settings and then click Control Panel. Click Add/
Remove Programs.

2 From the list of programs, select Nokia D211 and click Add/Remove.

3 The Welcome page of the uninstallation wizard opens. If you do not want
profiles and settings configured on the Settings page removed, select the Keep
all profiles and other settings check box. If you want to save all data relating
to the SMS application, for example text and picture messages you have sent
or received, select the Keep all data from the SMS application check box.

17
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Click Next to continue.

4 Check the uninstallation settings. To accept them, click Next. To change the
settings, click Back, make the changes, and then click Next.

5 The uninstallation starts. The Completion page informs you when the
uninstallation is completed. Click Finish.

18
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Getting started

Getting started

With the Nokia D211 you can:

® establish a General Packet Radio Service (GPRS) connection where information
is sent in short bursts of data over the cellular network. The benefit of sending
data in packets is that the network is occupied only when sending or receiving
data. GPRSisideal forapplications which transmit data in short bursts, such as
Web browsers. The data rate can be up to 40.2 kbit/s. You need to subscribe to
the GPRS service.

® connect to a GSM network where you can send and receive text and picture
messages. You can also connect to the Internet or your e-mail by making a data
call, which enables data transmission rates of up to 14.4 kbit/s. You can make
GSM high-speed data calls if your network supports High Speed Circuit
Switched Data (HSCSD) technology and you have subscribed to GSM high-
speed data services. HSCSD technology is especially suited for active file
transfer, and the data rate can be up to 43.2 kbit/s.

® connect to a Wireless Local Area Network (WLAN) and send and receive data
like in a regular wired LAN. The data rate in WLAN can be up to 11 Mbit/s.

Connecting to a network

© Nokia Corporation 2004. All rights reserved.

To be able to connect to a network you need a network profile. Easy connection
profile with pre-defined settings is automatically created during software
installation. This profile enables network access without your needing to
configure any settings.

If you want to create a profile yourself, see “Creating new profiles” on page 26
for more information.

You need a SIM card to be able to establish a GSM or GPRS connection.

To create a network connection:

1 Slide the SIM card into the smart card slot of the
Nokia D211. Make sure that the metal contacts of the
SIM card are facing down and that the bevelled
corner is on the right. Note that the radio card does
not support 5 Volt SIM cards.

19
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2 |Insert the radio card firmly into the PC card slot of
he computer.

Note that the radio card is not inserted all the way
into the PC card slot and there is a gap between the
protruding extension box and the computer. Do not
use excess force when inserting the card.

3 Switch on your computer.

4 |Ifyouare using a SIM card, enter the PIN code and click OK. You can enter the
PIN code before logging on to a network.

5 During the log on a dialog box opens in the top left-hand corner of the screen.
To select the profile and connection type at this stage, click Select.

6 The Select Connection dialog box opens. See Figure 5. From the list of profiles
open the profile and select the connection type you want to use.

& Select Connection B3

El Easzy connection

-~ GSM
-39 GPRS

-8 WLAN [ad hoc)
@ WLAM [infrastructure]

s i

E| by office

QK I Cancel

Figure 5 - Select Connection dialog box

WLAN - Connects you to a wireless local area network where you can send
and receive data.

GSM - Allows you to make data calls and utilise GSM high-speed data services
if your network supports HSCSD technology and you have subscribed to the
service.

GPRS - You can establish a GPRS connection and send packet data. You need
to subscribe to the GPRS service.

OFF - Disconnects the radio card from the network and turns off all radios.

7 Click OK to establish a network connection.

20
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Tip: You can access the Select Connection dialog box also by right-clicking
the Nokia D211 icon on the taskbar, or by opening the Profiles page of the
Manager window and clicking Select. If the taskbar icon is not visible, see
page 33 for more information.

Tip: You can manage network connections also by using the Nokia D211 icon
on the taskbar. Right-click the icon and click Connect to connect to SIM
services. To make a data call, click Dial, and to send packet data, click
Activate. See "Connection status indicators” below for more information. If
the taskbar icon is not visible, see page 33 for more information.

Warning: Do not use the radio card when the use of a wireless device is
prohibited or when it may cause interference or danger. Note that the radio
card may cause similar interference as any cellular device (e. g. mobile
phone) and must not be used in areas where the use of any such device is
prohibited.

Connection status indicators
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Taskbar icons and icons on the Profiles page indicate the status of the network
connection.

i

i

Ready for data call - You have established a connection to a GSM network
and can send and receive text messages. To access the Internet or your e-mail
by using GSM high-speed data services, you need to make a data call. Click
Dial to make a data call.

The use of GSM high-speed data services requires that your network supports
HSCSD technology and that you have subscribed to this service. For more
information, contact your service provider or network operator.

Data call to [phone number] - GSM data call is active. To finish the call, click
End Call.

Ready to activate GPRS - You have established a connection to a GSM
network that supports packet data sending (GPRS). You can send and receive
text messages. To access the Internet or your e-mail by using GPRS, you need
to establish a GPRS connection. Click Activate to establish a GPRS
connection.

You need to subscribe to the GPRS service. For availability and subscription
to packet data services, please contact your service provider or network
operator.

GPRS active - GPRS connection is now active. To end the connection, click
Deactivate.

Linked to (access point name) - You have established a connection to a
WLAN access point.

To connect to the SIM services, click Connect. The Connect button is
activated only when the wireless station has detected a service in the
network, otherwise the button remains inactive.
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Connected to SIM services - You have established a connection to SIM
services. To end the connection, click Disconnect.

Before you can take advantage of the SIM services, you must subscribe to
these services from your service provider or network operator and obtain
instructions for use.

tm Ad hoc network - You have either established or joined an ad hoc network.

;'? No network - You have selected Off as a connection type and are not
connected to any network.

Setting up and joining ad hoc networks

Ad hoc networks allow wireless stations to communicate directly with each other
without any WLAN access points. The stations can, for instance, share folders. One
user creates the ad hoc network and other users then join the network.

See "Wireless Local Area Network (WLAN)" on page 10 for more information on ad
hoc networks.

To connect to an ad hoc network:
1 On the Profiles page, select the General tab and click Select.

2 The Select Connection dialog box opens. Open the Easy connection profile
and select the WLAN (ad hoc) connection type. Click OK.

3 Ifyouarestartinganad hoc network, type the network name. If you are joining
a network, select the network name from the list box. Click OK.

E Tip: Create your own profile for ad hoc networking with the profile wizard if
you use the ad hoc operating mode frequently. This saves you from having to
select a network each time and allows for quicker access. See “Creating new
profiles” on page 26 for more information.

Ending network connections

Closing the Monitor or Manager window does not quit the program or end an
existing network connection. To end a connection, select the connection type Off
for a profile. See Figure 5 on page 20.

You can end the network connection also by stopping and removing the radio
card.

Removing the radio card
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You should always stop the radio card before removing it from the PC card slot of
your computer. To stop the card, right-click the Nokia D211 icon on the taskbar
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and select the option Stop card. If the taskbar icon is not visible, see page 33 for
more information.

& Caution:The Windows 98 Second Edition operating system stops all PC cards
— when a new PC card is inserted into the computer. If you insert another PC
card into your computer, make sure that you first stop the Nokia D211 and
remove it from the PC card slot. Otherwise you may lose the network
connection, which may result in loss of data.
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Manager and Monitor window

© Nokia Corporation 2004. All rights reserved.

The user interface of the Nokia D211 consists of the Monitor window and the
Manager window.

The Manager window is the main user interface of the Nokia D211. You can access
the Manager window by right-clicking the Nokia D211 icon on the taskbar and by
selecting Manager window from the shortcut menu.If the taskbar icon is not
visible, see page 33 for more information.
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Figure 6 - Manager window

The Manager window consists of the following pages: Profiles, Settings, and Tools.
The Administrator page is used by system administrators. The number of pages
may vary depending on which pages were selected during the installation. You can
view the different pages by clicking the icons on the icon bar on the left.

The Manager window is used for managing profiles, configuring settings, and
viewing network status.
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Using the Monitor window

The Monitor window is a small window displaying information on the current
network connection. The following information is available in the Monitor
window: connection type, amount of sent and received data, duration of the
connection, signal strength or WLAN connection quality, and data flow.

Maokia D211
GFPRS 00:01:34

| [

Figure 7 - Monitor window

To open the Monitor window, right-click the Nokia D211 icon on the taskbar and
select Monitor window. If the taskbar icon is not visible, see page 33 for more
information. If you want the Monitor window to open automatically each time the
radio card is inserted, go to the Settings page, General tab. Select the Open
Monitor window automatically option.

The Monitor window displays both the amount of sent and received data, and the
duration of the active connection. The data counter unit is a kilobyte. When the
data counteris displayed, click on it and the connection timer is displayed instead.

Note:The actual invoice for calls and services from your service provider may
vary, depending upon network features, rounding-off for billing, taxes and
so forth.

The signal strength indicator shows the strength and quality of the radio signal
between the radio card and a GSM base station at your current location. In WLAN,
the indicator shows the quality of the radio signal between a radio card and a
WLAN access point. Remember that the strength of the radio signal is affected by
distance and obstacles. The data flow indicator shows the relative speed at which
data is transferred.

Profiles page
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A profileis a group of network-specificand Windows networking settings. Profiles
enable easy transfer from one network to another without having to remember all
the different settings.

On the Profiles page you can create new profiles, modify and delete them. Profiles
can be saved to and opened from a file. You can also send profiles as text
messages.

Profiles are stored on a hard disk or SIM card.

One profile with pre-defined settings is automatically created during software
installation. This Easy connection profile enables network access without your
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needing to configure any settings. Note that this profile cannot be edited, deleted,
exported, or sent as a text message.

Selecting a profile and connection type

You need to select a network profile and connection type suitable for the network
in which you want the radio card to operate.

1 On the Profiles page, select the General tab and click Select.

2 The Select Connection dialog box opens. See Figure 5 on page 20. From the
list of profiles open the profile and select the connection type you want to use.
Click OK.

If you selected WLAN connection type, you are now connected to a WLAN
access point. To connect to SIM services, click Connect.

If you selected GSM or GPRS connection type, you are connected to a GSM
network, but to make a data call you have to click Dial, or to send packet data
you have to click Activate.

If you set the connection type to Off, the radio card is disconnected from the
network. See "Connection status indicators” on page 21 for a detailed
description of the various network statuses.

ﬁ Tip: You can access the Select Connection dialog box also by right-clicking
the Nokia D211 icon on the taskbar. If the taskbar icon is not visible, see
page 33 for more information.

ﬁ Tip: You can manage network connections also by using the Nokia D211 icon
on the taskbar. Right-click the icon and click Connect to connect to SIM
services. To make a data call, click Dial, and to send packet data, click
Activate. See "Connection status indicators” on page 21 for more
information. If the taskbar icon is not visible, see page 33 for more
information.

o Note: When you change a profile or connection type, you may need to
change your Web browser's proxy settings or domain settings for Windows
networking.

Creating new profiles
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By creating different profiles for different networks, you can easily switch from
one network to another without having to memorise the network settings.

1 On the Profiles page, select the Modify tab and click New.

2 The Welcome page of the profile wizard opens. To continue, click Next.

3 Give a name for the new profile. The name can consist of a maximum of 25
alphanumeric characters.

Select the appropriate connection type. You can use more than one connection
type with each profile. Click Next.
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4 |Ifyou selected WLAN connection type, you have to specify the following

WLAN options:

Operating mode - Select one of the two available operating modes. In the
infrastructure mode, computers can communicate with each other and with
wired LAN stations through a WLAN access point. In the ad hoc mode,
computers can send and receive data directly with each other. No access
point is needed. See "Wireless Local Area Network (WLAN)" on page 10 for
more information.

Network name - Type the network name as defined by the system
administrator, or select one from the list box. In the ad hoc operating mode,
the users themselves name the WLAN. The network name can consist of a
maximum of 32 alphanumeric characters. By default, the network name is
case-sensitive.

To continue, click Next.

If your local area network does not have a DHCP (Dynamic Host Configuration
Protocol) server, which would assign an IP address for the radio card
automatically, you need to specify the IP address, subnet mask, and default
gateway settings manually. Ask your system administrator for the correct
values.

Note: Make sure that the Manage TCP/IP properties together with
profiles check box is selected (Settings page, General tab). If this check
box is not selected, the TCP/IP settings are managed by network settings,
which can be configured in the Control Panel of your computer.

If you selected GSM connection type, you have to specify the following
settings:

GSM connection method - Select Analog if you are using a modem
connection. If you are using an ISDN connection, select ISDN V. 110 or ISDN
V. 120, depending on which ISDN standard your Internet service provider
supports.

GSM connection speed — The use of GSM high-speed data services include the
use of the following data transmission rates: 9.6 kbit/s, 14.4 kbit/s, 19.2 kbit/s,
28.8 kbit/s, and 43.2 kbit/s. Select the standard 9.6 kbit/s GSM data
transmission rate if the network you are using does not support HSCSD
technology. See "GSM properties” on page 30 for more information on data
transmission rates.

Note: The use of GSM high-speed data services requires that your
network supports HSCSD technology and that you have subscribed to this
service. GSM high-speed data services may cost more than normal GSM
data services. Contact your service provider or network operator for more
information.

Dial-up connection - Select a dial-up connection from the list or create a new
dial-up connection. Dial-up networking connects you to remote networks
using your radio card as a modem or ISDN adapter.

To continue, click Next.
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7 Ifyou selected GPRS connection type, you have to specify the GPRS access
point name. You obtain the access point name from your service provider or
network operator. If you select Use access point provided by network, the
network will connect you to an available GPRS access point automatically if
this feature is supported by the network. Click Next.

8 The Completion page of the profile wizard informs you when the creation of a
new profile is completed. Click Finish.

To take the new profile into use, you must first select it. See "Selecting a profile
and connection type" on page 26 for more information.

1 On the Profiles page, select the Modify tab and then select a profile from the
list. Click Edit.

2 Make the necessary changes and click OK. Profile-specific settings that can be
modified are explained on pages 28 - 32.

The Easy connection profile and profiles that are saved to a SIM card cannot
be edited.

o Note: Itisrecommended that you do not edit a profile that is currently in use.

WLAN properties: General tab
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Use WLAN connection with this profile
Select this check box if you want to use the profile for accessing a WLAN.

Operating mode

Select one of the two available operating modes. In the infrastructure mode,
computers can communicate with each other and with wired LAN stations
through a WLAN access point. In the ad hoc mode, computers can send and
receive data directly with each other. No access point is needed. See "Wireless
Local Area Network (WLAN)" on page 10 for more information.

Network name

Network name is the name of the WLAN as defined by the system administrator. In
the ad hoc operating mode, the users themselves name the WLAN. You can add a
new network name to the list, edit an existing one, or delete a name. The network
name can contain a maximum of 32 characters, and is case-sensitive by default.

Configure settings manually

There are a number of advanced WLAN settings (fragmentation threshold,

listen interval, RTS threshold, security policy, etc.), which are configured
automatically. Select this check box and click Advanced if you want to specify a
new value manually.
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7\ Caution: Do not change the settings manually unless you are sure how each
setting affects system performance. System performance may drop
dramatically if automatic settings are not used.

By default, you are automatically allocated an available radio frequency channel
without needing to specify one. You can, however, also select a particular channel
yourself: select Channel from the list of properties, clear the Automatic check box
and select a channel from the list. Make sure that the Nokia D211 and the WLAN
access point are using the same channel.

0 Warning: Using the Nokia D211 in some countries or regions may be illegal.
Consult local authorities on the regulations concerning the use of the
Nokia D211.

0 Warning: This equipment operates at 2.4 - 2.4835 GHz. Note that in France
the use of this equipment is only allowed at the frequency band of 2.445 -
2.4835 GHz (channels 10, 11, 12, and 13).

Use WEP security

Select this check box and click WEP Keys if you want to use Wired Equivalent
Privacy (WEP) keys for protecting the information transmitted in WLAN.

See "WEP security” on page 42 for more information.

WLAN properties: TCP/IP tab

Automated IP settings (DHCP) are enabled by default. When using DHCP (Dynamic
Host Configuration Protocol), you do not have to modify your IP settings when you
change your location.

If your local area network does not have a DHCP server, which would assign

an |IPaddress for the radio card automatically, you need to specify the IP addresses
manually. The advanced TCP/IP settings can also be specified and configured
manually. Ask your system administrator for the correct values.

WHLAN properties: SIM Services tab
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Use SIM services with this profile

SIM services refers to a service that enables you to access the Internet via your
service provider's or network operator's own public network. Your service provider
may, for example, offer you the possibility of checking data from your company
intranet, send and receive e-mail, and save documents. SIM services are usually
available in public places such as hotels, airports, railway stations, business
centres, and corporate buildings.

A SIM card is used as a means for user identification and billing. The SIM card is
provided by the service provider or network operator.

o Note: Before you can take advantage of SIM services, you must subscribe to
these services from your service provider or network operator and obtain
instructions for use.
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Service provider domain

Type the domain name, as in company.com. You cannot connect to SIM services
without specifying the domain name. You obtain the name from your service
provider or network operator.

Prompt when a SIM service is detected

When you are connected to a WLAN and a SIM service is detected, you are asked
whether you want to get connected. Once you have confirmed that you want to
get connected, you will be authenticated to the service.

Enable advanced connection controlling

Your wireless station sends keep-alive signals on a periodic basis to an access
controller in order to check the validity of the connection. If the wireless station
receives no response, the connection is ended automatically. If you select this
check box, your wireless station and the access controller can exchange additional
signals, which enables a quicker detection of lost connection.

o Note: The use of GSM high-speed data services requires that your network
supports the HSCSD technology and that you have subscribed to this service.
GSM high-speed data services may cost more than normal GSM data
services. Contact your service provider for more information.

Remember to select the Nokia D211 as the modem in each data and fax
communications application. Note that the modem settings have to be separately
changed in each application.

Use GSM connection with this profile

Select this check box if you want to use the profile for making data calls. When
you have an active data call, you can access the Internet and send and receive e-
mail, for example.

GSM connection method

Select the appropriate data call type. Select Analog if you are using a modem
connection. If you are using a ISDN connection, select ISDN V.110 or ISDN
V.120, depending on which ISDN standard your service provider supports.
Contact your service provider for more information on which remote ISDN
connections are supported.

GSM connection speed

Select the data transmission speed. The number of timeslots used is indicated in
parenthesis and the receiving transmission rate is mentioned first.

9.6 KBIT/S The standard GSM data transmission rate. Select this option if
(1+1) the network you are using does not support HSCSD technology,
or you have problems with making a data call.
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14.4 KBIT/S Can be used if it is supported by the network. Do not use this
(1+1) option unless you are sure your network supports it.

19.2 KBIT/S Doubles the standard 9.6 kbit/s GSM data transmission rate.

(2+2) You can select this option if your network supports HSCSD
technology and you have subscribed to GSM high-speed data
services.

28.8 KBIT/S Triples the 9.6 kbit/s transmission rate, or doubles the

(2+2) 14.4 kbit/s transmission rate. This option is ideal for working
with e-mail.
You can select this option if your network supports HSCSD
technology and you have subscribed to GSM high-speed data
services.

43.2 KBIT/S Triples the 14.4 kbit/s transmission rate. This option is ideal for
(3+1) downloading Web pages since the radio card receives data
faster than it sends data.

You can select this option if your network supports HSCSD
technology and you have subscribed to GSM high-speed data
services.

HSCSD technology allows for the use of multiple timeslots during a data
connection. Data transfer is symmetric when the sending and receiving
transmission rates are the same, for example 2 timeslots + 2 timeslots. Symmetric
data transfer is ideal for working with e-mail. Data transfer is asymmetric when
the receiving transmission rate is higher than the sending transmission rate, for
example 3 timeslots + 1 timeslot. This is ideal for downloading Web pages or files.
Due to the nature of the network, data transmission rates may change during a
data connection.

You can see the receiving and sending data transmission rates on the Profiles
page under the Operating information area.

Dial-up connection

Select a dial-up connection from the list or create a new dial-up connection using
the Windows dial-up wizard. Dial-up networking connects you to remote
networks using your radio card as a modem or ISDN adapter.

Use GPRS connection with this profile

Select this check box if you want to use the profile for sending and receiving
packet data.

Use access point provided by network

Select this if you want the network to select a GPRS access point for you. The
network will connect you to an available GPRS access point automatically if this
feature is supported by the network.
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Specify access point name manually

If you obtain the GPRS access point name from your service provider or network
operator, select this check box and type the name. An access point name is needed
to establish a connection to a GPRS network.

Removing profiles

On the Profiles page, select the Modify tab and then select a profile from the list.
Click Delete.

The Easy connection profile cannot be deleted.

Profiles that are stored on a SIM card can only be removed by the system
administrator.

Importing and exporting profiles

On the Profiles page, select the Modify tab and then click Import. Select the
folder from which you want to import a profile.

Similarly, you can save a profile in a folder. Click Export, and select the folder
where you want to save the profile.

The Easy connection profile cannot be exported.

The system administrator can import profiles from and export profiles to a
SIM card.

Sending a profile as a text message
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Make sure you have either a GSM or GPRS connection type selected. You cannot
send or receive text messages when connected to a WLAN.

The Easy connection profile cannot be sent as a text message.
1 On the Profiles page, select the Modify tab and select the profile you want to
send as a text message. Click Send.

2 The Send Profile Via SMS dialog box opens. Type the phone number of the
recipient in the box or click Select and select it from the list of contacts stored
on your SIM card.

The dial-up connection that has been specified for the profile is sent
automatically with the profile. Dial-up connections are needed when you want
to make a data call (GSM connection) or send packet data (GPRS connection).

3 Click Send to send the text message.

Note: A profile may be made up of several text messages. Therefore, sending
one profile may cost more than sending one text message.
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Settings page

On the Settings page you can set properties that are common for all profiles. These
settings will remain unchanged even when you switch to using another profile or
connection type. The GSM and WLAN settings apply to corresponding connection
types only.

For the changes to take effect, click the Apply button. If you have made changes
to the settings but have not yet clicked Apply and wish to restore the previous
settings, click Restore.

General settings (General tab)
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Manage TCP/IP properties together with profiles
By default, TCP/IP settings are managed as defined in each profile.

When the Manage TCP/IP properties together with profiles check box is
cleared, profiles will be activated without TCP/IP settings. You can change the
settings manually in the Control Panel of your computer.

Do not establish network connection automatically

When this check box is selected, the Select Connection dialog box opens
automatically when you start your computer or insert the radio card. In the dialog
box you can select the connection type you want to use. The default connection
type is Off. See Figure 5 on page 20.

If you clear this check box, every time you start your computer or insert the radio
card, the connection that was last used is established automatically.

0 Warning: It is recommended that you have this check box selected. It can
prevent you from accidentally establishing a network connection in areas
where the use of wireless device is prohibited or when it may cause
interference or danger.

Alert when connection status changes

If this check box is selected, you hear an alert tone every time the status of the
network connection changes.

Open Monitor window automatically

When you insert the Nokia D211 into your computer, a small icon appears on the
taskbar. By right-clicking this icon a shortcut menu opens, and you can access the
Monitor window from there. If, however, you want the Monitor window to open
automatically each time the card is inserted, select the Open Monitor window
automatically option.

Show icon on taskbar

If you select Show icon on taskbar, a small Nokia D211 icon will be displayed on
the taskbar whenever the radio card is inserted. If you clear this check box, you can
access the user interface of the Nokia D211 from the Start menu (Start, Programs,
Nokia, Nokia D211).
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Exit program when card is removed

If this check box is selected, you automatically exit the program when you remove
the radio card from the wireless station.

Basic GSM settings (GSM tab)

Automatic network selection

The GSM network to which your radio card is connected can be selected either
manually or automatically.

If the Automatic network selection check box is selected, the radio card
automatically selects one of the cellular networks available in your area. Outside
of the home network service area, the radio card will select one of the networks
that have a roaming agreement with the home network.

To select a network manually, clear the Automatic network selection check box
and click Search Networks. Select a network from the list of available networks
and click OK. If the radio card cannot reach the selected network or loses contact
with it, you are prompted to select another network.

o Note: If you select any other than your home network, this network must
have a roaming agreement with your home network operator.

Voice mailbox number

Type your voice mailbox number in this box. You obtain this number from your
service provider or network operator.

Display cell info

You can set the radio card to indicate when it is used in a cellular network based
on Micro Cellular Network (MCN) technology.

Display incoming calls

When this check box is selected, you will get a notification when you have a call
(data, fax) coming in.

Advanced GSM settings (GSM tab)

Call Divert
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A number of advanced GSM settings are network services: before you can benefit
from these services, you must subscribe to them from your service provider or
network operator and obtain instructions on their use.

To access these settings, select the Settings page and GSM tab. Click Advanced
Settings.

Call diverting is a network service that allows you to direct incoming voice, data
and fax calls to, for example, your voice mailbox number.
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To set the call diverts:
1 On the Settings page, select the GSM tab and click Advanced Settings.
2 The Advanced GSM Settings dialog box opens. Select the Call Divert tab.

3 From the Call type list, select the call type you want to be diverted (voice,
data, or fax).

4 Click Check Status to check whether the divert is activated or not. To set the
divert setting on, click Change.

5 Select where you want to direct your incoming calls and type the phone
number. Click OK.

6 Click OK to apply the settings and to close the dialog box.

To cancel all the active call diverts at once, click Cancel All Diverts.

To cancel only one call type divert, click Change and select Deactivate in the
Divert to list.

o Note: Make sure you have either the GSM or GPRS connection type selected
when setting call diverts or checking the status. When connected to WLAN,
you cannot configure these settings.

Call barring isa network service that allows you to restrict incoming and outgoing
calls so that calls cannot be received or made.

Activating call barring or changing the barring settings requires the barring
password, which you obtain from your service provider or network operator. See
“To change access codes” on page 38 for information on how to change the
barring password.

To set call barring options:
1 On the Settings page, select the GSM tab and click Advanced Settings.
2 The Advanced GSM Settings dialog box opens. Select the Call Barring tab.

3 From the Call type list, select the call type you want to bar (voice, data, fax, or
messages).

4 Click Check Status to ask the network for the call barring status. To set a
barring setting on, click Activate.

5 Type your barring password and click OK.
6 Click OK to apply the settings and to close the dialog box.

To disable all call barrings, click Cancel All Barrings. To disable only one call type
barring, click Deactivate.

o Note: Make sure you have either the GSM or GPRS connection type selected
when setting call barring options or checking the status. When connected to
WLAN, you cannot configure these settings.
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With the Nokia D211 you can send and receive text and picture messages. See
“Nokia Short Messaging” on page 46 for more information.

Any changes that you make to message settings affect the way in which your
messages are sent and received. The availability of some of the settings depends
on the service provider or network operator.

SMS application in use

Select the Short Message Service (SMS) application you want to use for sending
and receiving messages. The Nokia D211 includes the Nokia Short Messaging
application.

Message centre number

You need the message centre number to send messages. You receive the number
from your service provider or network operator.

Messages sent as

Text and picture messages are normally sent in text format, but it is possible to
convert them into an alternative format (e-mail, fax, paging). To be able to receive
aconverted message, the recipient must have an appropriate device available, and
the network must support this feature.

Message validity

If the recipient of a message cannot be reached within the set message validity
period, the message is removed from the message centre. If you select Maximum,
the validity period is set to the maximum time allowed by the network.

Reply via same message centre

Select this check box if you want to request the network to route the reply to your
message via your own message centre.

Delivery reports

Select this check box if you want to receive delivery reports on the messages you
have sent.

Send long messages

If the Send long messages check box is selected, messages longer than 160
characters are sent as concatenated messages. A concatenated message is
received asone long message if the recipient's device supports this function. If this
option is not selected, messages longer than 160 characters are sent as several
normal text messages.

Start SMS application when message is received

Select this check box if you want your SMS application, such as Nokia Short
Messaging, to open automatically when you have received a message.
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Use GPRS as preferred SMS bearer

You can select whether messages will be sent using GPRS packet data
whenever possible.

Sounds
If you want to be notified of an incoming call or message by a tone, select the
Alert on incoming calls and messages check box. Type the name of the wav file
in the appropriate text box or click the Browse button and select the file you want.
By clicking the arrow button you can listen to an example of the selected wav file.
WLAN settings (WLAN tab)

Enable power saving

Since a radio card has no direct wire connection of its own, it uses power from the
host computer. The Nokia D211 is equipped with a power saving option that
allows you to control the power consumption of your computer: you can prolong
the life of the battery when needed.

If you select the Enable power saving check box, the radio card is fully powered
up only when sending or receiving data. The card wakes up from the power saving
mode at reqular intervals to check if there is any data for it at a WLAN access
point, and wakes up immediately when there is any outgoing data.

o Note: The speed of communication decreases when the power saving option
is used.

o Note: The power saving option may not be compatible with WLAN access
points that are not Wi-Fi (Wireless Fidelity) approved. Do not use power
saving with such access points.

Case-sensitive network names

By default, the name of the WLAN is case-sensitive. If you do not want the
network names to be case-sensitive, clear this check box.

Renew DHCP automatically when needed

If the network has a DHCP server and you want the system to allocate you IP
addresses automatically, select the Renew DHCP automatically when needed
check box. You can also renew your IP address whenever you want by clicking the
Renew DHCP Now button.

Security settings (Security tab)
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You can set various access codes and protect your radio card and SIM card against
unauthorised use.

Codes can only include digits from 0 to 9.
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PIN code request

The PIN (Personal Identification Number) code is usually supplied with the SIM
card. It protects your SIM card against unauthorized use. If you set the PIN code
request on, you are asked for the PIN code when you start the Nokia D211
program or insert the radio card, provided that you have inserted a SIM card into
the radio card. Click the Change button to change the status.

o Note: Some SIM cards do not allow turning off the PIN code request.

If you enteran incorrect PIN code three times in a row, the code is blocked and the
SIM card cannot be used. To change a blocked PIN code, you need a PUK (PIN
Unblocking Key) code. PUK is an 8-digit code supplied with the SIM card.

Security code request

The security code protects your radio card against unauthorised use, and is
supplied with the radio card. The preset code is 12345. Change the preset code and
keep the new code secret and in a safe place separate from your radio card.

If you key in an incorrect security code five times in succession, the radio card will
not accept the correct code for the next five minutes.

To change access codes:

You can change the PIN code, security code, and barring password. Note that
changing the barring password requires that the call barring service is activated
for your SIM card.

1 On the Settings page, select the Security tab and click Change Access Code.

2 The Change Access Code dialog box opens. Select from the list the access code
you want to change.

3 Inthe Current code box, type the code used presently.
4 In the New code box, type the new code.

o Note: The access codes may only include numbers from 0 to 9. The PIN
code length must be at least four and no more than eight digits. The
length of the security code is always five digits and the length of the
barring password is four digits.

5 In the Confirm new code box, type the new code again.
6 Click OK to apply the changes and to close the dialog box.

On the Tools page you find, for example, detailed information on the network
connections, you can run a series of fault diagnosis tests, and you can create
personal WEP keys.
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Setting counters

On the Counters tab you can view detailed information on the different types of
network connections made: number of connections, their duration, and amount
of data transmitted. You can also see how many text and picture messages you
have sent and received.

You can select a pre-defined time period for which information is shown, or set
the start and end time yourself.

You can save the information to an html or a csv file by clicking the Report button.
To clear all counters, click Clear.

Note:The actual invoice for calls and services from your service provider may
vary, depending upon network features, rounding-off for billing, taxes and
so forth.

Viewing history information

On the History tab you can monitor various connection events. You can select the
type of network and the level of detail to be reported.

You can save the information to an html or a csv file by clicking the Report button.
Note that only information that is currently on display is saved to a file. The file
can be useful if you need, for example, to contact technical support in problem
situations.

To remove all history information, click Clear.

Diagnosing faults

On the Diagnostics tab you can run a series of fault diagnosis tests to ensure that
the radio card and the software are operating correctly. If you encounter problems
in accessing a network, for example, the tests can help to identify the source of
the problem.

The tests check that the software files have not been modified, the settings
configured both on the Profiles and Settings pages are valid and do not conflict,
and all drivers have been installed correctly. If the card does not pass the test, you
are given advice on how to proceed.

To start the fault diagnosis test, click Start.

You can save the test result to a text file by clicking the Report button. The text
file can be useful if you need, for example, to contact technical support in problem
situations. Note that the content of this file is in English only.

Managing personal WEP keys
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Personal Wired Equivalent Privacy (WEP) keys are used for authenticating the user
ina WLAN. Personal keys are usually created by the system administrator, who can
store them on SIM cards and then distribute them to the users. Personal keys can
also be saved to a file. Since personal keys are not network specific, they cannot be
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saved together with profiles. They can, however, be saved to a file and used
independently from profiles.

Personal WEP keys can be used only with the infrastructure operating mode,
provided that the WLAN access point supports the keys. Ad hoc networks use
shared WEP keys only.

See "Creating and editing personal WEP keys" on page 44 for more information.

Administrator page

The Administrator page is meant for system administrators and is not installed as
part of the normal installation procedure. On the Administrator page, the system
administrator can view detailed information on the network connections and save
important data on a SIM card. The administrator can create installation disks that
include relevant network profiles and settings, and that then can be distributed to
end users within a corporation, for example.

Monitoring information on WLAN

On the WLAN tab you can view general information on various elements of a
WLAN. Depending on the type of access point in use, the details displayed can
include network name, data rate, channel, signal strength, and IP address.

Select from the following items:

Access points - In the infrastructure operating mode, shows which WLAN access
points are currently in range and available.

Networks - Shows all the wireless local area networks that can be accessed with
the radio card.

Wireless stations - In the ad hoc operating mode, the names of the other
computers connected to the ad hoc network are displayed. Note that only the
names of those computers that are using the Nokia D211 are shown.

To update the information on display, click Refresh.

Viewing WLAN statistics
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On the Statistics tab you can view detailed information on the connection
between the Nokia D211and the WLAN access point to which you are linked. Both
graphical and numeric statistics are given for the following properties: connection
quality, received signal strength (RSSI), noise floor, signal to noise ratio (SNR), Tx
retry rate, and data flow.

If you want to save the information to a text file, click Start Logging.
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Creating installation disks

The system administrator can create installation disks that contain all the
software and necessary settings needed for accessing networks. The custom
installation package fits on a compact disk but can also be saved on a hard disk.

The installation disk can be used for distributing profiles. All the desired settings
and profiles can be copied to the installation disk, and the end user does not have
to configure settings in order to be able to connect to a network.

To generate an installation disk:

1

On the Administrator page, select the Installation Disk tab. Select from the
following options:

Profiles available — The list contains the names of all the profiles found in the
system registry. Select the profiles that you want to include in the installation
package.

Allow editing of selected profiles — The administrator can deny the editing of
those profiles that are distributed with the installation disk. The user can
create new profiles.

Include smart card driver- If you want other applications to be able to use the
smart card reader of the Nokia D211, you need to install a PC/SC (Personal
Computer Smart Card) compliant smart card driver. When this option is
selected, the smart card reader can be used with other applications besides the
Nokia D211, and with special types of smart cards.

Include basic settings from Settings page — Certain settings that have been
configured on the Settings page can be included in the installation package.
These include all settings configured on the General tab, GSM tab (no
advanced settings such as call diverts), and WLAN tab. These settings are
common for all profiles.

Create one file installation package - The installation package consists of only
one executable file. It contains the necessary files and drivers, and is easier to
distribute through e-mail, for example, than several separate files.

Include Administrator page - The entire Administrator page is included in the
installation package.

To start creating an installation disk with the selected profiles and options,
click Create.

3 Select the destination folder and click OK.

Managing SIM card contents
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The system administrator can store important information such as personal WEP
keys and network profiles on a SIM card. The administrator can then give users
SIM cards, which contain the necessary network settings and encryption keys for
quick network access.
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Transferring files from the computer to the SIM card and vice versa is done by
using a drag-and-drop operation or by using the Copy, Move, and Delete buttons
on the SIM Card tab.

For the changes to take effect, click Apply. Note that the button is inactive if there
is not enough free space on the SIM card. If you have made changes but wish to
restore the previous state, click Restore.

Distributing profiles

The system administrator can create profiles and then distribute them to end users
within a corporation. There are different ways for delivering profiles:

® Installation disks: the system administrator can create installation disks which
contain all the software and necessary settings needed for accessing networks
- including profiles. See “Creating installation disks" on page 41.

® Network: profiles can be saved to a folder on a network drive from which the
end user can import the profile. See “Importing and exporting profiles” on
page 32.

® SIM card: the system administrator can store profiles on SIM cards which can
then be distributed to end users. See "Managing SIM card contents” above.

® Text messages: profiles can be distributed by sending a text message that
includes a profile. See "Sending a profile as a text message” on page 32.

WEP security
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To increase the security of communication over the wireless local area network,
the Nokia D211 offers the Wired Equivalent Privacy (WEP) security feature. WEP
uses the RC4 algorithm with an up to 152-bit key. The algorithm provides for
security via two methods: authentication and encryption. Authentication is the
means by which one wireless station is verified to have authorisation to
communicate with a second station in a given coverage area.

In the infrastructure operating mode, authentication is established between a
WLAN access point and each wireless station. If a wireless station receives a
packet that has not been scrambled with a correct key, the packet is discarded.
Encrypted messages can be opened by other radio cards only if they all use the
same encryption key. In the ad hoc operating mode, authentication is established
between each wireless station.

The level of security is dependent on the length of the key: the more bits there are
in the key, the longer it takes to decrypt the information sent and the higher the
level of security.

WEP keys consist of a secret key and a 24-bit Initialization Vector. For example,
the 128-bit WEP key has a 104-bit secret key that the user can set, and a 24-bit
Initialization Vector that cannot be controlled by the user. Many manufacturers
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refer to this 128-bit key as a 128-bit key, whereas some refer to it as a 104-bit key
(104+24). Both keys offer the same level of encryption and are therefore
interoperable.

ﬁ Tip: Regardless of how the WEP keys have been named, all keys are
" compatible as long as their length is the same. For example, keys that are 40
bits long, always consist of 5 alphanumeric characters or 10 hexadecimal
characters.

The Nokia D211 supports three key lengths: 40 (40+24), 128 (104+24), and 152
(128+24) bits. The 40-bit key is Wi-Fi (Wireless Fidelity) compatible.

There are two types of WEP keys: shared keys and personal keys.

Shared WEP keys

Shared WEP keys are shared by all wireless stations using the network or
subnetwork; only stations that have the correct key can receive and decrypt data.
The same key is loaded into the WLAN access point. Shared keys are usually
created by system administrators, who distribute them to users.

Shared keys are network-specific, and each network can have a maximum of four
different shared keys. A WLAN access point only transmits data using the active
key, but can receive data from wireless stations using any of the four shared
WEP keys.

Tip: If you have a profile that includes more than one network, it is
recommended that you use the same shared WEP keys with all these
networks.

Because the shared WEP keys are network-specific and user-independent, they
can be saved in a file together with profiles. Users can import from a file or a SIM
card profiles that include shared keys and that have been created by their system
administrator.

Shared keys can be used as the only form of WEP security or used together with a
personal key.

Personal WEP keys

Each wireless station can have an individual, personal WEP key. Personal keys are
used for providing additional security for wireless connections. They are usually
created by system administrators, who distribute them to users. A WLAN access
point uses a different key for each wireless station.

There are two types of personal WEP keys, and the difference between the keys is
the type of information that is used for identifying the user:

® Station-specific - Uses the MAC address of the radio card to identify the user.

® User-specific- Uses an identifier that the users can create themselves.

Unlike shared WEP keys, personal WEP keys are not network specific, and
therefore cannot be saved together with profiles. They can, however, be saved to
a file and used independently from profiles.
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Personal WEP keys can be used only with the infrastructure operating mode. Ad
hoc networks use shared WEP keys only.

Note: Not all WLAN access points support personal WEP keys. Ask your
system administrator for more information.

Creating and editing shared WEP keys

Shared WEP keys are usually created by a system administrator.

In the infrastructure operating mode, make sure that the same shared WEP key is
configured to the WLAN access point; if the access point and radio card are using
incompatible keys, they cannot communicate. Contact your system administrator
for details.

1 On the Profiles page, select the Modify tab. Select from the list the profile
with which you want to use a shared WEP key. Click Edit.

The Edit Profile dialog box opens. Select WLAN and General tab.

Select the Use WEP security check box and click WEP Keys.

Select from the four keys which one you want to modify. Click Edit.

Select the appropriate key length. Supported key lengths are 40, 128, and 152
bits. Remember that the more bits there are in the key, the higher the level
of security.

Type in the WEP key data in hexadecimal format. If you want to enter the WEP
key in text form, type the text in the In text form box. You can copy and paste
the text by using the CTRL+ C and CTRL+V key combinations respectively.

6 Click OK to save the shared WEP key.
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To select which shared WEP key to use, select the key and click Activate.
To empty the contents of the key, click Clear.

Creating and editing personal WEP keys
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Personal WEP keys can be used only with the infrastructure operating mode. Ad
hoc networks use shared WEP keys only.

Make sure that the same personal WEP key is configured to the WLAN access
point; if the access point and radio card are using incompatible keys, they cannot
communicate with each other. Contact your system administrator for details.

1 Go to the Tools page and select the Personal Keys tab. Click New to create a
new key, or click Edit to modify an existing one.

2 Give the personal key a name. You can also include a further description of the
key, such as the name of the network where the key is used.

3 Select the type of key you want to create: station-specific or user-specific. If
you choose a station-specific key, the MAC address of the radio card is used for
identifying the user. If you choose a user-specific key, you can choose the
identifier yourself.
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4 Select the appropriate key length. Supported key lengths are 40, 128, and 152
bits. Remember that the more bits there are in the key, the higher the level of
security. Click Generate. The system generates your personal key.

If you want to enter the WEP key in text form, type the text in the In text form
box. You can copy and paste the text by using the CTRL+ C and CTRL+V key
combinations respectively.

5 Click OK to save the WEP key.

Importing and exporting personal WEP keys

Instead of creating a personal WEP key yourself, you can import from a folder a key
created, for example, by your system administrator. You can export and save
personal keys in folders. The system administrator can import personal WEP keys
from a SIM card and export them to a SIM card.

1 Onthe Tools page, select the Personal Keys tab. Select the key you want to
save to a file and click Export. To open a key from a file, click Import.

2 |Ifyou are exporting a personal WEP key, select the destination to which you
want to save the key, and click Save. If you are importing a key, select the
source from which you want to import the key and click Open.

Selecting a personal WEP key

1 On the Profiles page, select the Modify tab. Select from the list the profile
with which you want to use a personal WEP key. Click Edit.

The Edit Profile dialog box opens. Select WLAN and General tab.

Select the Use WEP security check box and click WEP Keys.

Select the Use a personal WEP key check box and select a key from the list.
Click OK.
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Nokia Short Messaging
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The Nokia Short Messaging application enables you to manage text and picture
messages in a similar way that you manage e-mail: you can send and receive
messages, reply to a message, and forward a message.

The sending and receiving of messages requires that the Short Message Service
(SMS) is available in the GSM network you are using and it is activated for your
SIM card. Contact your service provider or network operator for details.

o Note: You cannot send or receive messages when connected to a WLAN.

[? Tip: You can access the Nokia Short Messaging application by right-clicking
" the Nokia D211 icon on the taskbar and by selecting SMS application
from the shortcut menu. If the taskbar icon is not visible, see page 33 for
more information.

The Nokia Short Messaging application consists of the following pages:
¢ The Inbox page contains the received messages.

[=¥ Received text message. If the message icon is green, you have not read
the message.

@I Received picture message.
£5] Message that you have forwarded to someone.
E Message to which you have replied.

E You have both replied to the message and forwarded it to someone.
Received business card.

* The Outbox page contains messages that are being sent or waiting to be sent.
If you write and send a new message when the radio card is not inserted in the
wireless station, you are connected to WLAN, or the GSM or GPRS connection
is lost, the unsent message is stored in Outbox. Outbox may contain several
unsent messages, which are then sent when the radio card is inserted, or a
proper network connection is established.

The messages can have the following statuses:
Sending - The message is currently being sent.

Waiting - The message is waiting for sending to become possible.

¢ The Delivery reports page contains information on the status of the messages
you have sent. This is a network service to which you must subscribe before
being able to use it.
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Possible statuses for sent messages are:
Delivered - The message has been delivered to the recipient.

Pending - The message has not been delivered to the recipient yet. If the
recipient of a message cannot be reached within the set message validity
period, the message is removed from the message centre.

Failed - The message could not be delivered to the recipient. The recipient was
not reached within the set message validity period and the message was
removed from the message centre.

® The Sent messages page contains a copy of each sent message.

* The Contacts page enables you to manage contact information and business

cards stored on the SIM card. You can create, edit, and delete contacts, and
send business cards as text messages.

Text messages

Before you can send any text messages, you need to save your message centre
number. See “Configuring message settings" on page 48 for more information.

Make sure you have either a GSM or GPRS connection type selected. You cannot
send or receive messages when connected to WLAN.

Sending text messages
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1

Click Iﬁ on the toolbar, or click New on the File menu. The Message Editor
dialog box opens.

In the Message field, type the message. The character counter above the field
shows how many characters you have left and in how many messages the text
will be sent.

0 Note: The standard length of a text message is 160 characters. Messages
longer than this can be sent as several normal text messages or as one
concatenated text message which is received as one long message if the
recipient's device supports this function. You can select the Send long
messages option on the Settings page of the Nokia D211. See
“Configuring message settings" on page 48 for more information.

You can attach a picture to the text message. See “Sending picture messages”
on page 49 for more information.

Click the Add Recipients button. Select the recipient from the list of contacts
on the left and click the arrow button pointing to the right. If you do not
have a contact card created for the recipient, type the phone number in the
Number box and click the arrow button. Note that you can send the message
to several recipients.

When you have selected the recipients, click OK.

To send the message, click =[=7 on the toolbar.
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Replying to text messages

1 On the Inbox page, select the message to which you want to reply.

2 CIick% on the toolbar, or click Reply on the File menu. The Message Editor
dialog box opens.

3 Inthe Message field, type your reply.
4 To send the message, click =[=5] on the toolbar.

Forwarding text messages

1 On the Inbox page, select the message you want to forward. To forward a
message you have sent to someone, go to the Sent messages page and select
the message.

2 CIick-é]' on the toolbar, or click Forward on the File menu. The Message
Editor dialog box opens.

3 Click the Add Recipients button. Select the recipient from the list of contacts
on the left and click the arrow button pointing to the right. If you do not
have a contact card created for the recipient, type the phone number in the
Number box and click the arrow button. Note that you can send the message
to several recipients.

When you have selected the recipients, click OK.

4 To send the message, click =[] on the toolbar.

Deleting text messages and delivery reports

To delete a text message

1 Onthelnbox page, select the message you want to delete. To delete an unsent
message, go to the Outbox page, and to delete a sent message, go to the Sent
messages page.

2 Click }( on the toolbar, or click Delete on the File menu. To delete all
messages, click Delete All on the File menu.

To delete delivery reports:
1 On the Delivery reports page, select the delivery report you want to delete.

2 CIickK on the toolbar, or click Delete on the File menu. By clicking the Clear
List button you can delete the whole list of reports.

Configuring message settings
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1 OntheTools menu, click Nokia D211.The Manager window of the Nokia D211
opens.

2 (o to the Settings page and select the GSM tab. Click Advanced Settings.
3 The Advanced GSM Settings dialog box opens. Select the Messages tab.
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4 Make the necessary changes. See "Messages” on page 36 for more

information.

5 When you have configured the necessary settings, click OK.

Picture messages

You can send and receive text messages that contain pictures. These messages are
called picture messages.

Note that:

® This function can be used only if it is supported by your network operator or

service provider. Only devices that offer picture message features can receive
and display picture messages.

Each picture message is made up of three text messages. Therefore, sending
one picture message may cost more than sending one text message.

Before you can send any picture messages, you need to save your message
centre number. See "Configuring message settings” on page 48 for more
information.

Make sure you have either a GSM or GPRS connection type selected. You
cannot send or receive messages when connected to WLAN.

Sending picture messages
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1

Click @ on the toolbar, or click New on the File menu. The Message Editor
dialog box opens.

To insert a picture, click [ on the toolbar. The Picture Library dialog box
opens.

Select the picture you want to attach to the message and click OK.

If there are no pictures available in the list, click E to draw a new picture or
import a picture from a file by clicking .See "Drawing and editing pictures”
on page 50 and “"Opening pictures from a file" on page 50 for more
information.

In the Message field, type the message. The character counter above the field
shows how many characters you have left and in how many messages the text
will be sent.

Click the Add Recipients button. Select the recipient from the list of contacts
on the left and click the arrow button pointing to the right. If you do not
have a contact card created for the recipient, type the phone number in the
Number box and click the arrow button. Note that you can send the message
to several recipients.

When you have selected the recipients, click OK.

To send the message, click =[=7 on the toolbar.
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Drawing and editing pictures

1 On the Tools menu, click Picture Library.
2 Todraw a new picture, cIickE on the toolbar. To edit a picture, select the
picture and click on the toolbar. The Picture Editor dialog box opens.

3 Move the mouse cursor to the desired position. The cursor appears as a pen on
the drawing area. Press down the left mouse button. Move the mouse to draw.
The left mouse button draws black colour, and the right mouse button draws
white colour. To stop drawing, release the mouse button. Click Save to save
the picture.

4 Click Close to close the Picture Library dialog box.

Saving pictures to a file

1 On the Tools menu, click Picture Library.
2 Select the picture you want to save to a file. Click EE on the toolbar.

3 Inthe Export Picture dialog box, type a name for the file. By default, pictures
are saved as picture message files in gms format. Click Save.

4 Click Close to close the Picture Library dialog box.
If you have received a picture message, you can add the picture to the Picture

Library by clicking Save Picture on the File menu.
Opening pictures from a file

1 On the Tools menu, click Picture Library.
2 Clickﬁ on the toolbar.

3 Inthe Import Picture dialog box, select or type the name of the file you want
to import to the Picture Library. Click Open.

4 Click Close to close the Picture Library dialog box.

Deleting pictures

1 On the Tools menu, click Picture Library.
2 Select the picture you want to remove and click }{ on the toolbar.
3 Click Close to close the Picture Library dialog box.

Contacts

Contacts are names and phone numbers that have been saved in the SIM card's
memory.
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Creating and editing contacts

1 On the Contacts page, click New to create a new contact. To edit a contact,
click Edit. The Contact Information dialog opens.

2 Type the name and phone number for the contact. Click OK.

If you receive a message from a phone number that is not stored on your SIM card,
you can save the number to the list of contacts by clicking Add To Contacts on the
File menu.

Deleting contacts

1 On the Contacts page, select the contact you want to delete.
2 Click K on the toolbar, or click Delete.

Sending business cards

Chat

When you send or receive a person's contact information, the term business card
is used. A business card is a contact card in a format suitable for transmission,
such as vCard format.

1 Onthe Contacts page, select the contact you want to send as a business card.
Click Send.

2 The Send Business Card dialog box opens. Type the phone number of the
recipient, or click Select to select the recipient from the list of contacts.

3 Click Send to send the business card.

Make sure you have either a GSM or GPRS connection type selected. You cannot
send business cards when connected to WLAN.

The chat function allows you to have a conversation with another person using
text messages. The other party must have either the Nokia D211 ora mobile phone
with the SMS capability.

Make sure you have either a GSM or GPRS connection type selected. You cannot
send or receive messages when connected to WLAN.

Configuring chat settings
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1 On the Tools menu, click Options.
2 You can configure the following chat settings:

You can specify the number of hours for which the chat messages are shown in
the Chat window during the conversation.

Chat name - Nickname that is displayed with your chat messages.

51



Nokia Short Messaging

Always show chat window on top - Select this if you want the chat window to
remain visible even when you have other applications open.

3 Click OK to apply the settings.

Starting a chat session

1 Onthe Contacts page, select the contact you want to start a chat session with.
Ifyou do not have a contact card created for the other party, you have to create
one first. See "Creating and editing contacts” on page 51 for more information.

2 Click on the toolbar, or click Chat on the Tools menu.

3 The Chat dialog box opens. Write the message in the Message field and
click GeD|.

4 When you receive a reply from the other party, the reply message is shown
automatically in the Chat window. It is not stored in Inbox.

You can save the chat conversation to a text file. Click E on the toolbar to save
the file.

You can also attach pictures to your chat messages. See "Picture messages” on
page 49 for more information on how to handle pictures in messages.
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Troubleshooting

Installation

The installation program is interrupted.
Make sure you have enough power on your computer.
Make sure you have enough free disk space on your computer.
Make sure you have enough resources available in the system.

Check that you have closed all Windows programs before starting the installation,
and that you have not inserted the radio card into your computer until prompted
to do so by the installation program.

The CD-ROM drive cannot be opened during installation.

Some CD-ROM drives cannot be opened when installing software from them. If
you think that you might need the operating system files during the installation,
itisadvisable that you first copy the Nokia D211 installation files to the hard drive
of your compatible PC and install the program from there.

The radio card cannot be inserted into the PC card slot.
Check that the radio card is turned the right side up.
Check the PC card slot for any problems.

After inserting the radio card, it takes a while before the computer responds.

There might be a pause while the driver initialises the radio card. This is normal.
Please wait until the next message box appears and tells you what to do. This
should not take more than a few minutes.

Installation to a network drive fails.

You cannot install the Nokia D211 software onto a network drive. The software
must always be installed on a local hard drive.

| do not have a CD-ROM drive on my computer.

Using another computer, copy the installation program on floppy disks. On the
CD-ROM there is a folder at English\Setup. Copy the contents of this folder on
floppy disks. It is recommended that you then copy the contents of the disks to the
hard drive of your compatible PC before installing. If installed directly from the
floppy disks, the system will ask you to change the disk several times.
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Network

The radio card seems to be working, but the network connection does not work.

Run the fault diagnosis tests on the Tools page. If all tests are passed successfully,
make sure that the network settings are correct. Ask your system administrator
for advice.

In Windows 98/Me, Network Neighborhood does not show my computer name at all. Other
computers cannot see my computer name in Network Neighborhood either.

Open the Network dialog box (click Start, Settings, Control Panel, Network) and
click the File and Print Sharing button. Make sure that the | want to be able to
give others access to my files check box is selected. Other users should now be

able to see your computer in Network Neighborhood. If you share folders on your
computer, other users can see them too.

| cannot access the Internet.

When using a WLAN connection type, check that you use a routing protocol such
as TCP/IP.

Make sure that the proxy settings in the Web browser are correct.

Also make sure that there is a connection from your network to the Internet.

Resources

The radio card does not work and this is probably caused by another installed device.

Check that the radio card is not trying to use an 1/0, IRQ, or memory address used
by another device in your computer. To check the status of resources in Windows
98/Me, click Start - Settings - Control Panel - System - Device Manager -
Network Adapters. If there is a conflict, a yellow symbol is shown in front of the
name of the device.

Hardware

| am not sure if the radio card is working.

Check in the Monitor window that the radio card is working. You can also check
the Status page for the status of the connection.

There are no resource conflicts, but the radio card still does not work.

Check that the operating environment does not cause damage or interference to
theradio card. Detailed information on the operating environment can be found in
the chapter "About data transmission” on page 8.
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Troubleshooting

Check that the radio card is properly inserted.
Run fault diagnosis tests on the Tools page.

You can try to determine whether the problem lies with the computer or the radio
card by using the card in another available PC card slot, by installing the card in
another computer, or by using another card in the first computer.

The radio card does not work in another PC card slot, but works in another computer.

Try to insert another PC card in the slot to determine if there is a compatibility
problem between the Nokia D211 and the PC card slot, or if there isa general fault
with the slot.

The SIM card is not detected by the radio card.
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Make sure that you are using a correct type of SIM card. The radio card does not
support 5 Volt SIM cards.

Make sure that the SIM card is inserted correctly: the connectors on the SIM card
and the radio card must meet.

o Note: You can find the latest troubleshooting information in the readme.txt
file on the Nokia D211 CD-ROM.

ﬁ Tip: On the Tools page you can run fault diagnosis tests and save the test
results to a text file. The report can be useful if you need, for example, to
contact technical support in problem situations.
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Care and maintenance

Care and maintenance
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Your radio card is a product of superior design and craftsmanship and should be
treated with care. The suggestions below will help you to fulfil any warranty
obligations and to enjoy this product for many years.

Keep the radio card and all its parts and accessories out of small children's
reach.

Keep the radio card dry. Precipitation, humidity, and all types of liquids or
moisture can contain minerals that will corrode electronic circuits.

Do not use or store the radio card in dusty, dirty areas.

Do not store the radio card in hot areas. High temperatures can shorten the life
of electronic devices, and warp or melt certain plastics.

Do not store the radio card in cold areas. When it warms up (to its normal
temperature), moisture can form inside, which may damage electronic circuit
boards.

Do not attempt to open the radio card. Non-expert handling may damage it.

Do not drop, knock, or shake the radio card. Rough handling can break internal
circuit boards.

Do not use harsh chemicals, cleaning solvents, or strong detergents to clean
the radio card.

Do not paint the radio card. Paint can prevent proper operation.

Use only the supplied antenna. Unauthorised antennas, modifications, or
attachments could damage the radio card and may violate regulations
governing radio devices.

All of the above suggestions apply equally to your radio card or any accessory. If
any of them is not working properly, take it to your nearest qualified service
facility. The personnel there will assist you and, if necessary, arrange for service.
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Important safety information

Important safety information

Traffic safety

Do not use the radio card while driving a vehicle. Do not place the radio card on
the passenger seat or where it can break loose in a collision or sudden stop.

Remember: road safety always comes first!

Operating environment

Remember to follow any special regulations in force in any area and always power
off your radio card whenever it is forbidden to use it, or when it may cause
interference or danger. Note that the radio card may cause similar interference as
any cellular terminal (e.g. mobile phone) and must not be used in areas where the
use of any such device is prohibited.

Use the radio card in its normal operating positions.

Electronic devices
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Most modern electronic equipment is shielded from radio frequency (RF) signals.
However, certain electronic equipment may not be shielded against the RF signals
from your radio card.

Pacemakers

Pacemaker manufacturers recommend that a minimum separation of 20 cm (6
inches) be maintained between a radio card and a pacemaker to avoid potential
interference with the pacemaker. These recommendations are consistent with the
independent research by and recommendations of Wireless Technology Research.
Persons with pacemakers:

® Should always keep the radio card more than 20 cm (6 inches) from their
pacemaker when the radio card is powered on.

® Should not carry the radio card in a breast pocket.

¢ [f you have any reason to suspect that interference is taking place, power off
your radio card immediately.

Hearing aids
Some digital radio cards may interfere with some hearing aids. In the event of such
interference, you may want to consult your service provider.

Other medical devices

Operation of any radio transmitting equipment, including radio cards, may
interfere with the functionality of inadequately protected medical devices.
Consult a physician or the manufacturer of the medical device to determine if
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Important safety information

they are adequately shielded from external RF energy or if you have any questions.
Power off your radio card in health care facilities when any regulations posted in
these areas instruct you to do so. Hospitals or health care facilities may be using
equipment that could be sensitive to external RF energy.

Vehicles

RF signals may affect improperly installed or inadequately shielded electronic
systems in motor vehicles (e.g. electronic fuel injection systems, electronic anti-
skid (anti-lock) braking systems, electronic speed control systems, air-bag
systems). Check with the manufacturer or its representative regarding your
vehicle. You should also consult the manufacturer of any equipment that has been
added to your vehicle.

Posted facilities
Power off your radio card in any facility where posted notices so require.

Potentially explosive atmospheres

Vehicles
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Power off your radio card when located in any area with a potentially explosive
atmosphere and obey all signs and instructions. Sparks in such areas could cause
an explosion or fire resulting in bodily injury or even death.

Users are advised to power off the radio card when at a refuelling point (service
station). Users are reminded of the need to observe restrictions on the use of radio
equipment in fuel depots (fuel storage and distribution areas), chemical plants, or
where blasting operations are in progress.

Areas with a potentially explosive atmosphere are often but not always clearly
marked. These include below deck on boats; chemical transfer or storage facilities;
vehicles using liquified petroleum gas (such as propane or butane); areas where
the air contains chemicals or particles, such as grain, dust, or metal powders; and
any other area where you would normally be advised to turn off your vehicle
engine.

Do not store or carry flammable liquids, gases, or explosive materials in the same
compartment as the radio card, its parts or accessories.

Forvehiclesequipped with an air bag, remember thatan air bag inflates with great
force. Do not place objects in the area over the air bag or in the air bag deployment
area. If the radio card is improperly placed and the air bag inflates, serious injury
could result.

Using your radio card while in the air is prohibited. Remove your radio card from
the PC card slot before boarding an aircraft. The use of radio cards in an aircraft

may be dangerous to the operation of the aircraft, disrupt the wireless telephone
network and may be illegal.

Failure to observe these instructions may lead to suspension or denial of
telephone services to the offender, or legal action or both.
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Antenna
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Important safety information

This product model has been tested and meets radio frequency exposure
guidelines when used in a position that keeps the antenna at least 2.0 cm from
your body when the product is switched on.

As with any other radio transmitting device, do not touch the antenna
unnecessarily when the product is on. Contact with the antenna affects

connection quality and may cause the radio card to operate at a higher power
level than otherwise needed.
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Glossary

Glossary

Access controller

Ad hoc

Barring password

Physical device that manages permission and restrictions for logging onto a
computer or network.

One of the two WLAN operating modes that can be selected when using the Nokia
D211. With this configuration option, users can set up a wireless local area
network where wireless stations can send and receive data directly with each
other without WLAN access points. This type of network is sometimes called a
peer-to-peer network.

The barring password is a 4-digit code needed to change call barrings. The
password is not located in your radio card or SIM card, but in the network. You
obtain the password from your service provider or network operator when you
subscribe to the call barring service.

Dual-band functionality

GPRS

GPRS access point

GSM

Home network
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Dual-band functionality provides seamless roaming between networks during a
call within the same network operator. In practice, this means that you are less
likely to get "Network busy” messages. When you are abroad, dual-band
functionality gives more roaming possibilities, depending on your network
operator's roaming agreement.

General Packet Radio Service. GPRS is a technology that enables sending and
receiving data over a mobile network. GPRS as such is a data bearer that enables
wireless access to data networks like the Internet. The applications that use GPRS
are SMS messaging and the GPRS dial-up (for example, Internet and e-mail).

Interface between a GPRS network and external packet data networks, such as
the Internet.

GSM (Global System for Mobile Communications) is a digital telecommunications
system used widely in Europe, Asia and the Pacific.

Your home network is the network run by the operator that issued your SIM card.
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HSCSD

Infrastructure

Network operator

Network services

Picture message

PIN code

Profile

PUK code
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Glossary

High Speed Circuit Switched Data. HSCSD technology enables a data transmission
speed of up to 43.2 kilobits per second. HSCSD technology is based on the use of
multiple timeslots at the same time. The transmission speed in a single timeslot is
9.6 or 14.4 kilobits per second.

One of the two WLAN operating modes that can be selected when using the Nokia
D211. With this configuration option users can set up a wireless local area
network where wireless stations communicate with wired and wireless stations
through a WLAN access point.

A network operator maintains a cellular telecommunications network in a specific
area, often in a particular country. Several network operators may have
overlapping networks.

Network operators offer a variety of network services, including GSM data
services such as the Short Message Service (SMS), both to individual subscribers
and service providers. Not all network operators provide exactly the same services.

Special services provided by network operators and service providers. These
services must be subscribed to, and typically include the Short Message Service
(SMS), data service and fax service.

Text message that contains pictures. Each picture message is made up of several
text messages. This function can be used only if it is supported by your network
operator or service provider. Only devices that offer the picture message feature
can receive and display pictures.

Personal Identification Number code. PIN code (4 to 8 digits) is an access code for
protecting a SIM card against unauthorised use.

Aprofileisagroup of network-specificand Windows networking settings. Profiles
enable easy transfer from one network to another without having to remember all
the different settings.

PIN Unblocking Key code. PUK is a 8-digit code supplied with the SIM card. The
code is needed when you want to change a blocked PIN code. You cannot
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Security code

Service provider

Short message

SIM card

SMS

Text message

WEP

Wireless station

WLAN

Glossary

change the PUK code. If you lose the code, contact your service provider or
network operator.

The security code is supplied with the radio card. It protects your radio card
against unauthorised use. Keep the code secret and in a safe place, separate from
the radio card. If you key in an incorrect security code five times in succession, the
radio card will not accept the correct code for the next five minutes.

A company that offers telecommunications services, such as network services. A
service provider may be a network operator or a separate company.

See "Text message”.

Subscriber Identity Module card. A small plastic card with an embedded
integrated circuit. The SIM card contains all the information the cellular network
needs to identify the network user. The SIM card also contains security-related
information.

Short Message Service. SMS is a network service provided by network operators or
service providers. |t enables sending and receiving short text messages over the
digital cellular network. The standard length of a text message is 160 characters.

Short message that is sent over the digital cellular network. The standard length of
a text message is 160 characters.

Wired Equivalent Privacy. A security feature using the RC4 algorithm that
performs wireless data encryption. The WEP algorithm uses up to 152-bit keys.

Any computing device with a PC card slot, into which the radio card can be
inserted in order to send and receive data.

Wireless Local Area Network. A local area network in which radio links are used to
connect devices instead of physical cables.

WLAN access point
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Physical device that connects wired and wireless networks together.
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LIMITED MANUFACTURER'S WARRANTY
PART OF EUROPE & AFRICA REGION

This limited warranty shall apply in part of Nokia Mobile
Phones' Europe &t Africa Region unless a local warranty
exists. Nokia Corporation, Nokia Mobile Phones (“Nokia")
warrants that this NOKIA product ("Product”) is at the time
of its original purchase free of defects in materials, design
and workmanship subject to the following terms and
conditions:

1 This limited warranty is given to the end-purchaser of the
Product ("Customer"). It shall neither exclude nor limit i)
any mandatory statutory rights of the Customer or ii) any
of the Customer's rights against the seller/dealer of the
Product.

2 The warranty period is twelve (12) months from the date
on which the first Customer purchased the Product. In
case of a subsequent purchase or other change of owner/
user, such warranty period shall continue for the
remaining part of the twelve (12) month period and
otherwise remain unaffected. This limited warranty is
onlyvalid and enforceable in the following countries: any
member state of the European Union, Iceland, Norway,
and Switzerland.

3 During the warranty period Nokia or its authorized
service company will repair or replace, at Nokia's sole
discretion, a defective Product. Nokia will return the
repaired Product or another Product to the Customer in
good working condition. All parts or other equipment for
which replacements have been provided shall become the
property of Nokia.

4 Arepaired or replaced Product will not be given a
prolonged or renewed warranty period.

5 This limited warranty will not cover painted covers or
other similar personalized parts. In all cases that require
unlocking or locking of an operator SIM-lock, Nokia will
firstdirect the Customer to such operator for unlocking or
locking of the operator SIM-lock before repairing or
replacing the Product.

6 This limited warranty shall not apply to deteriorations
due to normal wear and tear. This limited warranty shall
further not apply if:

(i) the defect was caused by the fact that the Product has
been subjected to: use in contradiction with the owner's/
user manual, rough handling, exposure to moisture,
dampness or extreme thermal or environmental
conditions or rapid changes in such conditions, corrosion,
oxidation, unauthorized modifications or connections,
unauthorized opening or repair, repair by use of
unauthorized spare parts, misuse, improper installation,
accident, forces of nature, spillage of food or liquid,
influence from chemical products or other acts beyond
the reasonable control of Nokia (including but not limited
to deficiencies in consumable parts and breakage or
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damage to antennas) unless the defect was caused
directly by defects in materials, design or workmanship;

(ii) Nokia or its authorized service company was not
notified by the Customer of the defect within thirty (30)
days after the appearance of the defect within the
warranty period;

(iii) the Product was not returned to Nokia or its
authorized service company within thirty (30) days after
the appearance of the defect within the warranty period;

(iv) the Product serial number, the accessory date code or
the IMEI number has been removed, erased, defaced,
altered or isillegible;

(v) the defect was caused by a defective function of the
cellular or wireless LAN network;

(vi) the defect was caused by the fact that the Product
was used with or connected to an accessory not
manufactured and supplied by Nokia or used in other
than its intended use;

(vii) the Product software needs to be upgraded due to
changes in cellular or wireless LAN network parameters;

(viii) the defect was caused by a defective function of the
computer to which the Product was connected;

(ix) the changes in the computer (including but not
limited to updates or other changes in its operating
system) to which the Product was connected cause
malfunction of the Product.

7 To claim this limited warranty the Customer shall present

either i) a legible and non-modified original warranty
card which clearly indicates the name and address of the
seller, the date and place of purchase, the product type
and the IMEI or other serial number or alternatively ii) a
legible and non-modified original purchase receipt which
contains the same information, if such purchase receipt is
presented to the seller/dealer of the Product.

8 Thislimited warranty is the Customer's sole and exclusive

remedy against Nokia and Nokia's sole and exclusive
liability against the Customer for defects or malfunctions
of the Product. This limited warranty replaces all other
warranties and liabilities, whether oral, written, (non-
mandatory) statutory, contractual, in tort or otherwise.
Nokia is in no event liable for any incidental,
consequential or indirect damage, costs or expenses.
Neitheris Nokia in any event liable for any direct damage,
costs or expenses, if the Customer is a legal person.

9 Any change or amendment to this limited warranty

requires Nokia's prior written consent.



FILL IN WITH BLOCK LETTERS

Purchaser's Name:

Address:

Country:

Phone:

Date of Purchase (dd/mm/yy): _ [ [
Product Type (on type label): _ __ _ -
Product Code (on type label):

Product Serial No (on type label):
/ /

Place of Purchase:

Store Name:

Store Address:
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